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ENFORCEMENT DIVISION
CITATION, STYLE, AND USAGE GUIDE
JUNE 2012

PART ONE: PAGE LAYOUT AND FONTS

1.

General style for main text: Times New Roman; 12-point font; double line
spacing. Same, but single space for memoranda.

> TIP: Apply the Word style “Main Text-Enf” to main text in
reports and briefs to the Commission, and “Memo-Main Text-Enf”
style for memoranda to the Commission. See Appendix B.

Margins: 6.5 inches of text per line (i.e., one-inch margins).
Block quotations:

a. For quotes of 50 or more words in text, use block quotes.

Indent the entire quote an additional %-inch on each side, omit the
quotation marks, and single line space. Set the paragraph format to
include a 12-point space “after” each paragraph to create a single-line gap
between the block quote and the return to standard text.

> TIP: Apply the Word style “Block Quote-Enf” for formatting
block quotes in normal text. See Appendix B.

C. Cite the source for the block quote with no indent in the next line, and in
reports and briefs commence double space type again (or just reselect
Word style “Main Text-Enf.”).

d. Do not use block quotes in footnotes.
Footnotes:
a. 10-point font with a 0.5” indent following the footnote number and at the

beginning of new paragraphs within footnotes.

b. Set the paragraph format to include a 10-point space “after” each
paragraph to create a single-line gap between footnotes and between
paragraphs within footnotes.

> TIP: Apply the Word style “Footnote Text-Enf,” for formatting
footnote text. See Appendix B.

Italics: Use italics instead of underlines. Notwithstanding Bluebook rule 7(b), do
italicize foreign phrases and abbreviations, such as “i.e.,” “e.g.,” “a fortiori,”
“duces tecum,” “quid pro quo,” “[sic],” “sua sponte,” etc.



PART TWO: CASE AND OTHER CITATION FORMS

6. Source Names:

a. In citations, abbreviate all source names per Bluebook rules, including
abbreviation of the first word of a party name in a case or Commission
matter.
> Buckley v. Am. Constitutional Law Found.
> MUR 3774 (Nat’l Republican Senatorial Comm.)

b. If a source is named in a textual sentence:
> Do not abbreviate words (other than indications of corporate status,

such as “Co.,” “Inc.,” or “Ass’n”):

> Justice Blackmun concurred in California Medical.

> OR (if short form was previously given): Justice
Blackmun concurred in CMA.

> NOT: Justice Blackmun concurred in Cal. Med.

> Do not repeat the name in a citation at the end of that sentence

unless there is an intervening reference that creates ambiguity.

> In Buckley, the Court upheld these provisions. 424 U.S. at
15.

> NOT: In Buckley, the Court upheld these provisions.
Buckley, 424 U.S. at 15.

> BUT: In Buckley, as in McConnell, the Court upheld these
provisions. Buckley, 424 U.S. at 15.

C. Note: If the first citation to a source is in a footnote, the full cite should be
used the first time cited in the text, but once the full cite is used in the text,
the short form can be used in all subsequent footnotes.

7. Reporter and Court Abbreviations: Follow Bluebook Rule 6.1 concerning

spaces between abbreviations. Thus, there are no spaces within these reporter
abbreviations: F.2d, F.3d, U.S. There are spaces within these reporter
abbreviations (underscored here for clarity): F._Supp._2d, S._Ct. There are no
spaces within S.D.N.Y., D.D.C., and the like, but there are within E.D._Va.,
N.D._Cal., and the like.

8. Signals and Semicolons:

a.

With a few exceptions, citations are separated by semicolons, not periods,

even when there are multiple signals in a citation.



10.

11.

>  Buckley, 424 U.S. at 10; see also McConnell, 540 U.S. at 97.
» NOT: Buckley, 424 U.S. at 10. See also McConnell, 540 U.S. at 97.

Exceptions: As described further at Bluebook Rule 1.3, use a period before and
capitalize the Compare, But see (or Contra), and See Generally signal groups.

b. When using a signal as a verb in a textual sentence, do not italicize the
signal; if the textual signal contains the abbreviation “e.g.,” use the
unabbreviated form (“see, for example,”).

> For further information about the use and order of signals in
citations, see generally Rule 1 of the Bluebook.

Internet Addresses: Notwithstanding Bluebook Rule 18.2.2, for convenience of
the Commission, hyperlinks are permissible in citations to internet resources.

Internal Cross-references:
a. To simplify the editing process, a note in the nature of “as discussed above

[or below]” generally is preferred over the use of internal cross-references.

b. When necessary to refer with specificity to the location of other content in
the same writing, however, internal cross-references should refer to “p.” or
“pp.” or “Part,” not to “at” or “part” or “section” or “page.”

C. The supra/infra precedes the page or Part number.
> See infra pp. 4-5.

> Supra Part 11(A)(1).
> NOT: See pp. 4-5, infra.

Symbols: Use section and paragraph symbols; do not insert a comma between
the source and the symbol (Bluebook Rule 3.3):

> 2 U.S.C. §431(4); 11 C.F.R. 88 104.20, 114.15; see Compl. 1 43-45;
Singer Resp. 1 3.

>  NOT: Resp., 13.

a. Use nonbreaking spaces (shift + control + space) to avoid separating
section or paragraph signs from the number that follows at the end of a
line of text. Similarly, use nonbreaking hyphens (shift + control +
hyphen) to prevent numerical ranges (pages, sections, etc.) from carrying
across lines. Do not use tabs or hard returns for those purposes.

b. For citations to multiple subsections, use one section symbol, and place a
comma between subsections. E.g., 2 U.S.C. § 434(d)(1), (e)(2). For
citations to multiple (non-consecutive) sections, use two symbols, and



12.

13.

14.

place a comma between the sections. E.g., 2 U.S.C. 8§ 431(10), 434(d).
For citations to consecutive sections or subsections, use a hyphen. E.g.,
2 U.S.C. § 434(b)-(c); 11 C.F.R. 88 100-116.

And: Do not use “and” in citations to multiple pages, sections, or paragraphs or
string cites to multiple authorities; use a comma or semi-colon, as appropriate.
“And” may be used for those purposes, however, in textual sentences:

» 2U.S.C. 88 441c, 441f; 11 C.F.R. 88 109.21, 109.23.

>  See, e.g., MUR 3987 (Hughes Aircraft Co.); MUR 2314 (Santini).

» Compl.at2; Id., Ex. A at5.

» NOT: 2U.S.C. 88 441c and 441f; see, e.g., MUR 3987 (Hughes Aircraft
Co.) and MUR 2314 (Santini); Compl. at 2 and Ex. A at 5.

»  BUT: “Respondents deny they violated 2 U.S.C. 8§ 441c and 441f.”

Internal Quotation Marks:

a. When omitting internal quotation marks within a quotation, use the
parenthetical: “(internal quotation marks omitted).”

b. When including an internal quotation and using the “(quoting . . .)”
parenthetical, the quotation must include single quotation marks to
indicate the portion of the material that is a quote from the earlier source.

> “*The First Amendment is important.”” WRTL, 127 S. Ct. at 2667
(quoting Buckley, 424 U.S. at 10).

> NOT: “The First Amendment is important.” WRTL, 127 S. Ct. at
2667 (quoting Buckley, 424 U.S. at 10).

Short-form Parentheticals: When providing a short form in a parenthetical, use
quotation marks; if the parenthetical includes the word “the,” it should not be
included within the quotation marks:

> Federal Election Commission (“FEC” or “Commission”)

NOT: Federal Election Commission (FEC or Commission)

NOT: Federal Election Commission (“the FEC” or “the Commission™)

BUT: Hillary for President Committee (the “Committee”)

FEC v. Wisc. Right to Life, Inc., 127 S. Ct. 2652 (2007) (“WRTL”)

vV V VvV VYV VY

NOT: FEC v. Wisc. Right to Life, Inc., 127 S. Ct. 2652 (2007) (WRTL)



When providing a full cite and short-form for the Act in a textual sentence, as a matter of
general practice we place the parenthetical inside the commas marking the amendment:

>

The Federal Election Campaign Act of 1971, as amended (the “Act”),
prohibits a corporate contribution to a candidate.

15. Explanatory Parentheticals:

a.

Following citation to an authority that quotes or cites another authority,
place the word “quoting” or “citing” in a parenthetical containing a cite to
the secondary source, thus:

> “We acknowledge, as we must, that ‘the tie goes to the speaker.””
Id. at 231 (quoting WRTL, ... .)

> NOT Id. at 231, quoting WRTL, . . ..
> NOT Id. at 231, quoting WRTL, . . ..

NOTE: When citing a source for the purposes of a “citing” or “quoting”
parenthetical, the secondary source should be cited as it would if citing it
directly (i.e., the short form may be used if previously assigned). If,
however, the source cited or quoted has changed since the publication of
the source doing the citing or quoting, cite the version the original cites.

With reasonable exceptions, craft explanatory citation parentheticals in
one of two ways: either as a present participial phrase with no ending
period, viz,

advancing, acknowledging, approving, arguing, asserting,
cabining, characterizing, chastising, claiming, contending,
construing, deciding, demonstrating, disagreeing, eliciting,
eliminating, extending, finding, furthering, holding, identifying,
implicating, limiting, offering, opining, precluding, presenting,
promulgating, proposing, propounding, providing, proving,
qualifying, questioning, reasoning, recognizing, recommending,
rendering, remonstrating, stating, stressing, surveying, treating, etc.

or if quoting material that reads as a full sentence, draft the parenthetical
as a grammatically complete sentence beginning with a capital letter and
ending with a period, altering the quotation if necessary:

(“[A]ny suggestion that ‘major purpose’ must adhere to ‘majority
of spending’ finds no purchase in the opinions that created that
concept.”).



Substantive parentheticals should be reasonably concise; avoid including
multiple sentences in a parenthetical unless necessary to explain fully the
proposition cited.

Do not use block quotations in a citation sentence. Rather, quote as much
of the source as necessary in quotation marks within the explanatory
parenthetical, or treat the source further in a separate textual block quote.
(Same for footnotes — see above.)

An explanatory parenthetical should be provided whenever useful, but
must be included for any citation to authority that supports a proposition
indirectly or not obviously, that is, generally those authorities introduced
with a “see also,” “cf.,” “compare,” “see generally,” or “but cf.” citation
signal.

For multiple authorities cited in an “e.g.” style string cite for the same
proposition, a single parenthetical may be used after the final citation in
the form: “(each holding . . .),” “(none finding . . .),” “(all [or both] stating
...)," etc.

PART THREE: PUNCTUATION, CAPITALIZATION, SPELLING, AND NUMBERING

16.

17.

18.

Spaces: Leave two spaces after the period at the end of a sentence, two spaces
after colons, and one space after a semicolon.

Dashes and Hyphens:

a.

Use the dash — a handy punctuation mark — like this. Those are long
“em” dashes, not shorter “en” dashes (this mark “-~” is an en dash), with
spaces on either side. Use neither em nor en dashes to signify page ranges
(id. at 11-14); use a hyphen (without spaces) for this purpose.

> TIP: A shortcut keystroke for the em dash is available in Word by
depressing each of the following keys at the same time:
ctrl+alt+minus (on the number pad).

There’s no hyphen in an adjectival phrase that starts with an adverb. So
it’s “an obtusely worded rule” not “an obtusely-worded rule.” There can
be a hyphen in an adjectival phrase starting with an adjective or noun
(“ballot-access program™), but not where the adjectival phrase is a
common phrase in its own right (“ice cream cone,” “major purpose test”).

Commas:

a.

Use the final, Oxford (or “serial”) comma in a list of three or more
elements: For example, teachers love to teach about commas, colons, and
apostrophes.



19.

20.

21.

22.

23.

b.

Use commas before and after the year when reciting a complete date, but
not when stating only a month and year.

> Most commentators predict that the person inaugurated on January
20, 2013, will not be Buddy Roemer.

> Most commentators predict that the person inaugurated in January
2013 will not be Buddy Roemer.

Quotation Marks:

a.

Use smart (i.e., “curly”) quotation marks instead of dumb (i.e., "straight™)
quotation marks. When cutting and pasting text without them — e.g.,
from Westlaw, Pacer, or the E.P.S. system — use the search and replace
function in Word to alter them easily. For single quotation marks and
apostrophes, also use the ‘smart’ versions.

Periods and commas always go inside quotation marks. Semi-colons and
colons always go outside quotation marks. Question marks go inside or
outside, depending upon the meaning.

Ellipses:

a.

When using an ellipsis, the Bluebook format “. . .” is to use three periods
separated by spaces (with spaces before and after the ellipsis, too). Use
“hard” spaces [ctrl+shift+space] between the dots so the ellipsis will not
break across the end of a line of type.

A fourth period is frequently required, either before or after the ellipsis,
depending on whether the material being omitted precedes or follows the
end of the part of the particular sentence that is quoted. Also use a four-
period ellipsis (“. .. .”) on its own line to signify the omission of a
paragraph or paragraphs. Follow Bluebook rules 5.1(a) and 5.3(b) in these
situations.

Do not use an ellipsis at the beginning of a quotation. See Bluebook
Rule 5.3.

Contractions: Do not use contractions in reports or memoranda to the
Commission.

Possessives: People and nouns ending in “s” are made possessive with an
apostrophe-s. E.g., Congress’s, not Congress’; Adams’s, not Adams’. Plural
possessives use s-apostrophe: books’ bindings, three banks’ records.

Capitalization:

a.

Capitalize an independent clause that follows a colon; otherwise, don’t
capitalize after the colon: Here we have an independent clause following
a colon.



24,

25.

26.

b. Use “court” for all courts, except the Supreme Court.

C. When referenced in a textual sentence, capitalize documents filed with the
Commission (e.g., “Complaint,” “Response”).

d. constitutional, not Constitutional (unless discussing the Convention);
congressional, not Congressional; and presidential, not Presidential; but
the U.S. Constitution, the President, the Vice President, a Member of
Congress.

e. internet, not Internet

f. website, not Web site

g. federal or state, not Federal or State, unless quoting from another source
that uses a capitalized form, or for states, when reciting the formal title of
the territory, i.e., the State of Texas, the Commonwealth of Virginia

Spelling:

a. supersede, not supercede

b. decision-making, not decisionmaking or decision making

C. officeholder, not office-holder or office holder

d. e-mail, not email

e. Vice President, not Vice-President

f. pleaded, not pled

Numbers:

a. Write out numbers one through nineteen; for 20 and higher, use numerals.
We do not follow Bluebook Rule 6.2, which directs that numbers up to 99
be spelled out.

b. For percentages, either “fifty percent” or “50%” is acceptable — but do
not mix, i.e., not “50 percent.”

C. Do not use “st” or “th” when referring to dates, such as December 21st.
Just write the numbers without the suffix: “On December 21, the . ...”

d. Similarly, do not use superscript for ordinal contractions: e.g., (9th Cir.

2010), not (9™ Cir. 2010); 12th District of Virginia, not 12" District. In
citations, use “d” instead of “nd” when referring to the second anything:
“(2d Cir. 2010),” “F. Supp. 2d,” “(2d. ed. 2012).”

Page and Line Numbers:

a.

Pages should not be cited as “p.” or “pp.” except in internal cross-
references.



Notwithstanding Bluebook Rules B7.1.2 and 3.2(a), when citing
Commission-related documents, use “at” to set off page numbers from the
cited source (but not from section or paragraph symbols). Include a
comma before “at” only if confusing not to.

> First GCR at 3; Compl. at 6; Resp. { 21.

A colon is used to identify line numbers on a cited page. Consequently, to
cite both page and line numbers — for example, when citing to a transcript
of a deposition — cite the source “at” page, colon, line number:

> Yohalem Dep. at 34:1.

To cite multiple line numbers from a single page, use a hyphen and omit
the page number after the hyphen, but retain the colon:

> Yohalem Dep. at 34:1-:12.

To cite consecutive or multiple pages with line numbers, include the page
numbers following the hyphen:

> Yohalem Dep. at 34:1-35:22.
> Yohalem Dep. at 34:1-35:22, 66:23-:30, 102:5-:10, 110:1-123:30.

Do not shift from page and line number to just page numbers in a
hyphenated citation range: that is, cite “34:5-35:30” when the final line on
page 35 is line 30, not “34:5-35,” which creates confusion.

In general, when continuous pages, paragraphs, or sections repeat initial
digits, omit the repeating digits except the last two as described at
Bluebook Rules 3.2(a) and 3.3(b), unless the omission is confusing:

> Shasky, 233 F.3d at 123-34.

> 2 U.S.C. 88 438-45.

> Supplemental Submission at FEC 001234-46.

BUT because “110:1-23:30” may cause confusion, cite the final page
number in full:

> Yohalem Dep. at 110:1-123:30.

PART FOUR: USAGE AND DICTION

217.

Words and phrases to avoid or eliminate:

a
b
C.
d
e

“utilize”; use “use”

per (unless part of an expression like “miles per hour”)

“in order to” is rarely necessary; just use “to”

“and/or”; try to rephrase, e.g., “the gun, the bullet, or both.”
“try and”; use “try to”



f. restrictive “whiches” and non-restrictive “that’s”; use “that” for restrictive
elements, and “which” for non-restrictive items

> “That” modifies words or phrases that are grammatically
“restrictive,” meaning what follows “that” is necessary to the
meaning of the sentence because it narrows the modified term to a
specific class or type, while “which” modifies non-essential
elements: e.g., “The opinion that causes some regulatory
uncertainty in this area, Citizens United, held . . .” and “Citizens
United is the opinion that causes some regulatory uncertainty in
this area” (for each, not “which causes”), but “judicial opinions,
which are countless, are unhelpful when not well reasoned” (not
“that are countless™). Put simply, “whiches” are expendable,
“thats” are not, and that’s how one knows which to use.

g. “(s)”; revise. E.g., contend that there is reason to believe “one or more
unknown respondents” violated the Act, not “unknown respondent(s).”

h. “however” at the head of a sentence; as a general matter, that which is
contradicted is more readily appreciated when the term follows the subject
it modifies: e.g., “The respondent’s point, however, runs contrary to the
central holding of the authority he cites.”

28. Honorifics: Once a proper name has been introduced in full, as a matter of
consistency in treatment among reports to the Commission, avoid unnecessary
honorifics in subsequent references; just cite by surname (except when referring
to relatives who share a surname):

> Respondent Stephen J. Lund claims he did not intend to avoid any
disclosure requirement. Lund contends. . . .

> NOT: Mr. Lund contends . . . .
> Senator McCain filed a Response. In that Response, McCain stated . . . .

> NOT: In that Response, Sen. McCain stated . . . .

PART FIVE: HEADINGS
29. Typeface and Format:

a. Use the I.A.1.a.i outline format. Indent each level 0.5” (using tabs or
margin stops, not spaces), and adopt the following textual conventions:

l. LEVEL 1 HEADING
A Level 2 Heading
1. Level 3 Heading
a. Level 4 Heading

I. Level 5 Heading




30.

> TIP: Use Word styles “Enf. Heading Lvl. 1, 2,3 .. ., etc.

b. For capitalization in headings, follow the Bluebook: *“Capitalize words . . .
[except] articles, conjunctions, and prepositions when they are four or
fewer letters, unless they begin the heading . . . or immediately follow a
colon.” The Bluebook: A Uniform System of Citation, Rule 8(a) (19th ed.
2010) (emphasis added).

Parallelism

a. All headings in a piece should have at least one parallel heading; for
example, preferably a document should not contain a heading “a” without
a parallel heading “b.”

b. Headings may be written as full sentences or contain argument, but need
not, so long as a particular heading level is treated consistently throughout
the document. Thus:

d. Respondent’s Scheme to Conceal the Reimbursements Provides
Reason to Believe She Acted Willfully

OR
d. Willfulness
BUT NOT
d. Reimbursements
e. Respondent’s Scheme to Conceal the Reimbursements Provides

Reason to Believe She Acted Willfully

11



APPENDIX A:
FORM OF CITATION FOR COMMISSION
AND OTHER COMMONLY RECURRING MATERIALS

. QUICK REFERENCE SHEET

Complaint:

Response:

Supplement:

Attachment:

Exhibit:

Table:
AOs:

MURs:

Depositions:

Newspaper:

E-mail:

Letter:

Compl. at 12.

Compl. 1 1.

Compl. 8§88 12(a)-(c), (e).
Compl., Attach. 1.
Compl., Exs. 2-4, 7.

Resp. at 12.
Resp. § 23.

Shirley Supp. 1 12
Supp. at 12, thl.1

Compl., Attach. A.

Compl. at 3, Attach. A.
Compl., Attach. A at 2.
Compl. at 3, Attach. A, E, Q.

Compl., Ex. A.
Compl. at 3; id., Ex. A.
Compl., Ex. A at 2.
Compl., Exs. A, E, Q.

Compl., thl.1, fig. 4

General Explanatory Notes

Precede pin-cites to page numbers with “at”
and include a comma only if clarity requires.

Use a space with no comma following the
source in cites using section or paragraph
symbols.

Commas may be used to set off exhibits,
tables, attachments, figures, and the like from
a source.

For Commission-related documents, employ
the abbreviation conventions identified in
Bluebook tables BT1, T6, T9, T10, T11, T12,
T13, and T16.

For citations to a series of pages, sections,
paragraphs, or sources, do not use “and” to
between elements, except in textual sentences.
Instead, use a comma or semicolon as
appropriate.

Advisory Op. 2007-01 (McCaskell)

MUR 4382 (Dole for President)

First GCR at 4, MUR 5819 (U.S. Chamber of Commerce).

Statement of Reasons of Comm’rs. Mason, Wold & Smith at 5, MUR 4382 (Dole).

Leland Brendsel Dep. at 22:12-:23 (June 23, 2003).

John M. Broder, Geography is Dividing Democrats over Energy, N.Y. TIMES,

Jan. 27, 2009, at A3.

E-mail from Erica Lee, Audit Project Mgr., FEC, to Daniel A. Petalas, Assoc.
Gen. Counsel, FEC (Jan. 21, 2012, 07:30 EST).

Letter from Mary Miles, Treasurer, McCarthy for Pres., to Jeffrey S. Jordan,
Supervisory Attorney, FEC (Apr. 4, 2010).

A-1




1. ENFORCEMENT RELATED DOCUMENTS
A. Matter Under Review
First: MUR 5405 (Hynes for Senate, et al.)
Short: MUR 5405
Mult.: See, e.g., MUR 5405 (Hynes for Senate, et al.); MUR 4919 (Charles Ball for Congress);
MUR 4646 (Habie)
NOT: “MURs 5405, 4445, 3210” in citations
B. Non-Complaint Generated Matters Under Review

First: Pre-MUR 520 (Ensign, et al.)
Short: Pre-MUR 520

C. Complaint

First: Compl. at 8 (Dec. 12, 1999)
Short: Compl. at 1

D. Sua Sponte Submission
AICPA PAC Sua Sponte Submission at 2 (Sept. 28, 2007), Pre-MUR 452 (AICPA PAC)
E. Audit Referral
AR 07-01 at 5 (Richard Morrison Congr. Comm., et al.)
F. RAD Referral
RRO4L-01 at 3 (Take Back the House)
G. Response to Complaint
First: Resp. at5 (May 12, 2004)
Hynes for Senate Resp. at 6 (Nov. 1, 2004)
Short: Resp. at 3
Hynes for Senate Resp. at 3
H. Supplemental Response
First: Supp. Resp. at 5 (June 2, 2010)
Hynes for Senate Supp. Resp. at 6 (Dec. 12, 2004)

Short: Supp. Resp. at 12
Hynes for Senate Supp. Resp. at 1
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. Reports (instant matter)
First: Second Gen. Counsel’s Rpt. at 3 (“Second GCR”)
Short: Second GCR at 3

Third GCR tbl.5

J. Reports (other matter)

First: First Gen. Counsel’s Rpt. at 4, MUR 5819 (U.S. Chamber of Commerce) (“First GCR”)
Short: First GCR at 6, MUR 5819

K. Factual and Legal Analysis (instant matter)
First: Factual & Legal Analysis at 3 (“F&LA”)
Short: F&LA at3
Case for Senate F&LA at 2
L. Factual and Legal Analysis (other matter)
First: Factual & Legal Analysis at 5, MUR 5487 (Progress for America) (“F&LA”)
Short: F&LA at 5, MUR 5487
Case for Senate F&LA at 2, MUR 5819

M. Response to Reason to Believe Finding

RTB Resp. at 2
Hynes for Senate RTB Resp. at 3

N. Probable Cause Brief (instant matter)
PCBr.at4
O. Probable Cause Brief (other matter)
PC Br. at 103, MUR 3774 (Nat’l Republican Senatorial Comm.)
P. Response to Probable Cause Brief

First: Resp. to PC Br. at 5, MUR 3774 (Nat’l Republican Senatorial Comm.)
Short: Resp.to PC Br. at 6

Q. Probable Cause Hearing Transcript (instant matter)

First: PC Hr’g Tr. at 15 (Mar. 28, 2007)
Short: PC Hr’g Tr. at 46
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First:
Short:

First;
Short:

First:
Short:

First:

Short:

First:

Short:

First:
Short:

First;
Short:

R. Probable Cause Hearing Transcript (other matter)

PC Hr’g Tr. at 15 (Nov. 30, 1999), MUR 3774 (Nat’l Republican Senatorial Comm.)
PC Hr’g Tr. at 34, MUR 3774

S. Supplemental Probable Cause Brief

Supp. PC Br. at 3, MUR 5818 (Fieger, et al.)
Supp. PC Br. at 6, MUR 5818

T. Conciliation Agreement
Conciliation Agreement § 1VV.7, MUR 6344 (UPW) (“CA”)
CATIV
CA 1V, MUR 6344
U. Statement of Reasons
Statement of Reasons, Comm’rs. Mason, Wold & Smith at 5, MUR 4382 (Dole for
President, et al.) (“SOR”)
SOR at 5, MUR 4382
SOR at5
SOR, Comm’rs. Mason, Wold & Smith at 5 [if citing dueling SORs in same report]
OTHER COMMISSION DOCUMENTS
A. Policy Statements
Statement of Policy Regarding Commission Action in Matters at the Initial Stage in the
Enforcement Process, 72 Fed. Reg. 12,545, 12,546 (Mar. 16, 2007) (“Policy Statement”)
Policy Statement, 72 Fed. Reg. at 12,547
B. Advisory Opinions

1. Advisory Opinion Request

Advisory Op. Req. at 3, AO 2007-09 (Kerry-Edwards 2004) (“AOR 2007-09”)
AOR 2007-09 at 3

2. Supplemental Information

Supp. to Advisory Op. Reg. at 3, AO 2007-09 (Kerry-Edwards 2004) (“Supp. AOR”)
Supp. AOR at 3

3. Close Out Letter
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First: Letter to Hon. Douglas Applegate at 1 (Apr. 4, 1995), Advisory Op. Req. 1995-4
(ApplePAC) (“Close Out Ltr.”)
Short: Close Out Ltr. at 1

4, Comments
First: Comment of Campaign Legal Ctr. & Democracy 21 (July 2, 2007) at 3, AO 2007-09
(Kerry-Edwards 2004)
Short: Comment at 3, AO 2007-09

5. Ex parte communication

First: Ex Parte Communication from Blythe Horman to Mary W. Dove, Comm’n Sec. at 2
(Feb. 4, 2004), AO 2003-37 (Americans for a Better Country)
Short: Horman Ex Parte at 2, AO 2002-37

6. Advisory Opinion

First: Advisory Op. 2003-37 (Americans for a Better Country) at 6 n.10 (“AO 2003-37”)
Short: AO 2003-37 at 6 n.10

7. Concurrence or Dissent to AO

First: Concurrence of Comm’rs. Mason, Smith & Toner at 2, AO 2003-03 (Cantor)
Short: Concurrence of Comm’rs. Mason, Smith & Toner at 2, AO 2003-03
Concurrence of Comm’rs. Mason, Smith & Toner at 2

8. Request for Reconsideration

First: Reqg. for Reconsideration (Feb. 28, 1980) at 2, AO 1979-48 (Rexnord, Inc.) (“ROR”)
Short: ROR at 2, AO 1979-48

C. Rulemakings

1. Commencing Document

First: Letter from James Bopp, Jr., Gen. Counsel, James Madison Ctr. for Free Speech, to Amy
Rothstein, Asst. Gen. Counsel, FEC (Jan. 26, 2010) (“Pet. for Rulemaking™).
Short: Pet. for Rulemaking at 2.

2. Notice of Proposed Rulemaking

First: Federal Election Activity and Nonfederal Elections, 72 Fed. Reg. 31,473, 31,475
(proposed June 7, 2007) (to be codified at 11 C.F.R. pt. 100)
Short: 72 Fed. Reg. at 31,475
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3. Comments

Comment of N.J. Democratic State Comm. at 2 (July 9, 2007), Federal Election Activity and
Nonfederal Elections, http://sers.nictusa.com/fosers/showpdf.htm?docid=11618

4. Ex parte Communication

Ex Parte Communication of AFL-CIO to Comm’r Weintraub at 2 (Dec. 7, 2005), Coordinated
Communications, http://sers.nictusa.com/fosers/showpdf.htm?docid=1265

5. Supplemental Materials

Supp. Materials, Airing of Presidential Media, Coordinated Communications,
http://sers.nictusa.com/fosers/showpdf.htm?docid=57108

6. Explanation and Justifications

First: Candidate Solicitation at State, District, and Local Party Fundraising Events, 70 Fed.
Reg. 37,649, 37,652 (June 30, 2005) (revised explanation and justification) (“E&J”)
Short: E&J, 70 Fed. Reg. at 37,653

7. Statement of Commissioner

First: Statement of Comm’r Smith, Public Hearing on Prohibited and Excessive Contributions
at 3 (June 4, 2002) (“Statement of Comm’r Smith”) (cautioning that President raised
“concerns about the constitutionality of portions of” the BCRA)

Short: Statement of Comm’r Smith at 2

D. Commission Hearing Materials
1. Transcripts

First: Tr. of Open Meeting at 15 (Jan. 18, 2007)
Short: Meeting Tr. at 46

2. Audiotapes
First: Hr’g Audiotape (Nov. 18, 2010), Advisory Op. 2010-23 (CTIA),

http://www.fec.gov/audio/2010/2010111802.mp3
Short: Hr’g Audiotape, AO 2010-23
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V. INVESTIGATIVE MATERIALS
A. Affidavit or Declaration

First: Scott Freda Aff. at 2 (Aug. 12, 2005)
Short: Freda Aff. at 3

First: Scott Freda Decl. at 2 (Aug 12, 2005)
Short: Freda Decl. at 3

B. Investigative Interview Reports

First: Report of Investigation of  (0)(6) at 2 (Dec. 1, 2005) (“(b)(6) ROI™)
Short: (©)(6) ROl at 3

First: FBIFD-3020f  (b)(6) at 4 (Feb. 4, 2011) (“(b)(6) 302”)
Short: (0)(6) 302 at 6

C. Deposition

First: Leland Brendsel Dep. at 22:12-:24 (June 23, 2003)
Short: Brendsel Dep. at 22:12-:24

D. Deposition Exhibit

First: Government Relations Policy and Procedures Manual at 5 (Jan. 12. 2009), Leland
Brendsel Dep., Ex. 5 (June 23, 2003)

Short: Brendsel Dep., Ex. 5, at 5

E. Produced Documents

Confirmation of Accuracy and Receipt of Government Relations Policy and Procedures Manual
at FM-FEC 005038 (July 1, 2003)

F. Attachments

Freddie Mac Vendor Payment History, Bank of Am. Sua Sponte Submission, Attach. 5 (Apr. 12,
2004)

V. OTHER PUBLISHED, UNPUBLISHED, AND INTERNET SOURCES
A. Newspaper

Jerry Burris, Awkward Campaign Bumps Could Unhinge Case’s Efforts, HONOLULU
ADVERTISER, Sept. 20, 2006, at A6
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David S. Cloud & Greg Jaffe, For Bush, the Path to War with Iraq Gets More Complex, WALL
ST.J., Sept. 3, 2002, at Al

B. Magazine
Robert J. Samuelson, A Slow Fix for the Banks, NEWSWEEK, Feb. 18, 1991, at 55
C. Online publication
The Republican Governors’ Opinion: More on What Candidates Can, or Cannot, Do with

“527s (Jan. 13, 2004),
http://www.moresoftmoneyhardlaw.com/moresoftmoneyhardlaw/updates

Emily Bazelon, In Defense of the New Judicial Activists, SLATE (Aug. 9, 2010),
http://www.slate.com/id/2263347/

D. Letters and E-Mail

Letter from Mary Miles, Treasurer, McCarthy for Pres., to Jeffrey S. Jordan, Supervisory Att’y,
FEC (Apr. 4, 2010)

E-mail from Erica Lee, Audit Project Mgr., FEC, to Daniel A. Petalas, Assoc. Gen. Counsel,
FEC (Jan. 21, 2012, 07:50 EST)

E. Social Media Sources

@jack, Comment to TWITTER (June 8, 2010, 4:53 PM), http://goo.gl/AlkHu (“At #sqdc with
@crazybob for @Sowers and @Square. Come by and say hi! Local 16.”)

Founding Principles, Comment to FACEBOOK (Apr. 15, 2012, 6:11 PM),
http://www.facebook.com/#!/founding.principles/posts/335304553190175

Martinned, Comment to More on Section 7 of the Torture Convention, THE VOLOKH
CONSPIRACY (Jan. 29, 2009, 11:02 AM), http://www.volokh.com/posts/1233241458.shtml
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APPENDIX B:
USING WORD IN ENFORCEMENT DIVISION DOCUMENTS

How To Apply Styles: Assbceoc| Asebcede AaBRC: AaBbce AAB assice %

¥ Normal ! ¥No Spad.. Headingl Heading 2 Title Subtitie - Change

Styles ~
> Go to the “Home” tab Sles

> Highlight the text to which the Style will be applied;

Normal

> Under “Styles” (on the right side of the Home menu) click on _';'7‘:'7'*"”_' u
the button with a down arrow (circled above) to show a list of ’” ‘ 3 Lo :

the different types of styles. Title u

> Click the style you want and the highlighted text will be . 5 :
correctly formatted. . .

Strong -

OR Quate 1
> Choose the appropriate preexisting style box to apply to the 2
selected text. e :

Pre-Formatted Enforcement Division Styles: The IT Department has created a series
of styles for use in Enforcement Division documents that can be found in the Style Menu.
These include the following:

> Main Text-Enf: Use for text in the body of all reports or briefs to be submitted to
the Commission.

4

Memo-Main Text-Enf: Use for the text in the body of all memoranda.
> Footnote Text-Enf: Use for text in footnotes of all reports, briefs, or memoranda.

> Block Quote-Enf: Use for block quotes in the body of all reports, briefs, or
memoranda. Do not use block quotes in footnote text.

A

Heading Lvl. 1-Enf (and 2, 3, 4, and 5): Use for each designated heading level.
Word should automatically number (or letter) based on the previous entries using
the same heading style.



Widowed Headings: Use the “Keep with Next” function under the “Paragraph” tab to
force headings to the next page with related text. It may be necessary to highlight several
lines if multiple headings are nested or if blank lines separate headings from text. Avoid
using hard returns or page breaks for that purpose, except for the final signature page, if
necessary.

Small Caps: Small Caps (for use in citing newspapers and magazines and certain other
sources) are found under the Home menu. Click the diagonal down arrow by the Font
label to access the Font Dialog Box. With the relevant text highlighted, click the box for
Small Caps under the Effects menu.

Non-breaking Space: Join the periods in ellipses (“. . .”) and join section or
paragraph symbols with the letters or numbers that follow using non-breaking
spaces. To create a non-breaking space, type Ctrl-Shift-Space together instead of
the space bar alone.

> Despite its claim to the contrary, Respondent violated 2 U.S.C.
§ 441f,

NOT: Despite its claim to the contrary, Respondent violated 2 U.S.C. §
4411,

Shortcuts: Consider creating keystroke shortcuts for the section, paragraph, and

em dash symbols. Create a shortcut by selecting Insert on the Word menu, then

choose the Symbol icon on the far right of the menu. Choose More Symbols, then

follow these instructions:

a. Choose the tab for Special Characters.

b. Click the character to which you intend to assign a shortcut.

C. Click the button at the bottom of the box for shortcut key.

d. Type the key strokes you wish to use to generate the particular special
character within the “Press New Shortcut Key” box (e.g., Ctrl+4 serves as

a useful shortcut for the section character because $ looks like §).

e. Click the Assign button at the bottom left.
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